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Introduction
The CAPELLA Cochlear Emissions Analyzer is the most recent addition to the comprehensive line of audio diagnostic instrumentation
from GN Otometrics. Capella is a PC-based system which runs under
Microsoft® Windows™, either together with the NOAH/PAX software platform, or as a self-contained program. In addition to the
main unit containing the hardware, Capella consists of separate software modules, this documentation and accessories.
Capella evaluates both of the two broad classes of emissions, Spontaneous and Evoked, and two of the evoked emission types, Transient
and Distortion Product. Two separate modes are incorporated for
Transient emissions, Echo-Screen for rapid neo-natal and infant
screening, and TEOAE for clinical and diagnostic testing of all patients. Tests include amplitude and input/output determinations of
Evoked emissions, as well as spectral averages of Spontaneous emissions. A Tympanometry module is included for identifying hearing
problems arising in the middle ear.
CAPELLA Cochlear Emissions Analyzer is operated by an IBM or compatible personal computer via the built-in RS232C connection, and
offers the following unique features:

GN Otometrics A/S

•

Windows-based software running under NOAH or PAX.

•

Small, lightweight combination probe tip.

•

Separate Echo-Screen probe especially suited to infants and
new-born babies.

•

Each probe is individually calibrated for maximum probe
measurement accuracy.

•

Mounting options for probe assembly: shoulder harness,
standard sized headband or children´s headband.

•

Significantly reduced noise floor for threshold detection and
Input/Output tests.

•

Screening Tympanometry module.

•

Echo-Screen baby screening module.
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1.1

CAPELLA Cochlear Emissions Analyzer

Applications of Capella
CAPELLA Cochlear Emissions Analyzer is designed to measure the
low-amplitude audio frequencies transmitted from the cochlea
through the middle ear to the external ear canal and known as otoacoustic emissions. Otoacoustic emissions (OAE's) were first identified at the Royal National TNE Hospital, London, and have been
shown to be the result of an active mechanical process in the cochlea.
This process enhances the sound-induced motion of cochlear structures and increases the sensitivity and frequency selectivity of the
ear. OAE's are typically classified into two broad classes based on
the type of acoustic stimulation that evokes them, as described below.

1.1.1

Spontaneous Otoacoustic Emissions
Spontaneous Otoacoustic Emissions (SOAE's) are low-level narrowband signals measured in the absence of deliberate acoustic stimulation. They occur in only about one half of normal-hearing ears, and
at only a few frequencies for ears in which they do occur. Consequently, they are thought to have limited clinical utility although
they may have research implications.

1.1.2

Evoked Otoacoustic Emissions
Evoked emissions, which occur in nearly all normal-hearing ears,
are further divided into three sub-types according to the nature of
the acoustic stimulus used to elicit them. Transient Evoked Otoacoustic Emissions (TEOAE's) occur in response to brief acoustic signals (clicks, tone bursts, etc.). It has been suggested that they may be
particularly well-suited to detection of cochlear disorders, especially
in screening applications.
Stimulus-Frequency Otoacoustic Emissions (SFOAE's) are elicited
by swept pure tone signals and show characteristics similar to those
of transient emissions. However, because their detection is more
complicated and time-consuming than the measurement of TEOAE's, they have not yet been incorporated into clinical tests.
Distortion Product Otoacoustic Emissions (DPOAE's or DP's) are
evoked by two simultaneously presented pure tones of different frequencies. They represent the ear's nonlinear response to the stimulus tones, and consist of new frequencies not present in the eliciting
stimuli. Although DPOAE's are somewhat more complex to elicit
and analyze than TEOAE's, they may have greater clinical utility for
some applications.
Capella currently measures Spontaneous, Transient, and Distortion
Product Otoacoustic Emissions, using synchronous time averaging
(where applicable), correlation techniques and FFT frequency analy-
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sis to measure emissions whose sound pressure level is below that
of extraneous and body sounds and (where applicable) the evoking
stimuli. Echo-Screen uses statistical analysis to perform rapid measurement and classification of Transient Otoacoustic Emissions.
Capella also incorporates a Tympanometry module to diagnose or
eliminate middle ear disorders as a cause of hearing loss or potential
hearing problems identified by OAE measurement. This module
records the changes in the immittance of the middle ear associated
with changing static pressure in the ear canal. This pressure is swept
through a predetermined range by means of a digitally driven
pump.
The measurement techniques employed in Capella have several distinct advantages over more traditional audiologic tests:

GN Otometrics A/S

1.

Objectivity
No behavioural response is required from the patient.

2.

Time-efficiency
Some tests can be accomplished in less than a minute for both
ears.

3.

Non-invasiveness
No electrodes are required. No discomfort to the patient. Signal delivery and OAE response measurement are achieved
using a small probe held in place by a soft, disposable eartip.

4.

Sensitivity to cochlear function
Useful in the differential diagnosis of cochlear and retrococh-
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lear disorders. Capable of distinguishing sensory (cochlear)
hearing loss from neural hearing loss in site-of-lesion testing.
5.

Sensitivity to disorders of the middle ear and Eustachian tube

CAPELLA Cochlear Emissions Analyzer is intended for the following
applications:
•

Hearing screening
-Difficult-to-test patients, including infants
-Industrial (occupational hearing loss)
-Schools and itinerant patients
-Geriatric patients

•

Clinical evaluation
-Differential diagnosis (middle ear versus cochlear versus retrocochlear)
-Monitoring: progressive hearing loss, ototoxicity, noiseinduced hearing loss

•

Research

Measured properties of cochlear function include signal detection
threshold and response amplitude, frequency content, and growth.
•
•
•

Outer hair cells (OHC)
Basilar membrane
Efferent innervation

Capella complies with the following international standards:

1.2

•

Patient Safety: Complies with EN 60601-1.

•

Immittance testing: Comparative tympanometry according to
EN 61027 and ANSI S3.39.

The NOAH fitting platform
The Capella OAE application module may be integrated with HIMSA's NOAH program for fitting hearing instruments. NOAH uses a
common software platform and central database to integrate hearing instrument fitting systems, test equipment, and office management software systems. NOAH integrates client records,
audiological data and the dedicated fitting modules from various
hearing instrument manufacturers.
Digitally programmable hearing instruments using different technologies and different programming devices are available from a
number of manufacturers. NOAH provides a common software
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platform for fitting different brands of programmable hearing instruments. Alternatively, Capella can also run under PAX, HIMSA's
new software standard for ENT professionals.
Please read the NOAH or PAX User's Guide for detailed instructions
on how to install and run these programs.

1.3

About this manual
The Windows-based application software of Capella is so userfriendly that we are convinced that you will find operation of Capella
a very straightforward process. The simplicity of the screen layouts
together with online Help make the program very easy to use.
This manual describes Capella’s hardware and accessories, and also
includes an Operation Guide to the application software. Familiarity
with Windows is assumed.
Note:
Program diskette is located at the back of this manual!

1.4

System requirements
Recommended
IBM® or IBM compatible PC with the following:
32 MB RAM
Microsoft Windows 95 or 98
Pentium processor
VGA graphics adapter
Mouse
Color printer
1 free COM port
PC noise level under 35 dB (A)

GN Otometrics A/S
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Software installation
The Capella software is supplied on the diskette(s) enclosed in a plastic pocket at the back of this User Manual.
To install Capella on your PC, proceed as follows:

1.6

1.

Insert the diskette (or diskette #1 if there are more than one)
into your diskette drive.

2.

Use the Windows Run function to locate and run Setup on
the diskette.

3.

Windows will now start the Installation program. Just follow
the on-screen instructions.

4.

By default, the program will install Capella under the path for
NOAH.

5.

If you are not using NOAH, you may specify another path.
The Capella software is represented by a NOAH icon. You can
simplify start up by creating a short cut to Capella on the Windows desktop.

Starting up the system
If Capella is running under NOAH, first access NOAH´s Client Module. On the toolbar, only the first icon (Client Module) and the last
icon (Help) are active until a client has been selected - all the others
are greyed (inactive). Before proceeding to any of the application
modules, it is first necessary to access the Client Module, and then
to either select an existing client or to add a client to the database.
You are referred to the NOAH or PAX User's Guide for detailed navigation instructions.
After having selected or added a client, click on the Selection of
Measurement Module icon which opens the NOAH/PAX Measurement Selection Screen. Double-click on the Capella button. The
Capella software will now be loaded, and the program will start by
trying to connect with the Capella hardware platform - see next chapter.
If not running NOAH, start Capella by double-clicking on the NOAH
icon in the directory where you have installed Capella, or on the Windows desktop if you have made a short cut.
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2

The Capella Hardware

2.1

Safety

2.1.1

Symbols
This User Manual contains information and warnings which must
be followed to ensure the safe performance of the CAPELLA Cochlear
Emissions Analyzer. Local government rules and regulations, if applicable, should also be followed at all times.
Special note should be made of the following:
The Capella carries this symbol when it is important
that the user refer to associated warnings in this
guide.
The Capella and this manual are CE-marked according
to the Medical Devices Directive 93/42/EEC.
Classified with respect to electrical shock, fire, mechanical and other specified hazards in accordance
with UL2601-1 and CAN/CSA-C22.2 NO 601.1-90
Capella is marked with this symbol to indicate compliance with Type B requirements of EN 60601-1.
This class of equipment is allowed in domestic establishments when used under the jurisdiction of a
health care professional.

GN Otometrics A/S
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Safety precautions
Capella has been designed and tested in compliance with EN 606011 "Safety of Medical Electrical Equipment".
To ensure safe performance, Capella must be correctly installed and
the following safety requirements must be complied with.
Only the original power cable supplied with Capella must be used.
This must be fitted with an approved 3-pole mains (line) plug, which
has a protective earth conductor.
Capella should only be connected to an AC power supply which has
a protective earth conductor in accordance with EN requirements.
Caution:
Grounding continuity should be checked periodically.
Avoid using extension cables. The increased length of the cable may
increase the resistance of the protective earth conductor beyond an
acceptable level.
When assembling an electro-medical system, the person carrying
out the assembly must take into account that other connected equipment which does not live up to the same safety requirements as this
product may lead to a reduction in the overall safety level of the system.
When selecting accessories connected to the RS232 socket, the following points must be considered:
•

Use of connected equipment in a patient environment.

•

Evidence that connected equipment has been tested in accordance with EN60601-1 and/or EN 60601-1-1.

2.2

Installing the Capella hardware

2.2.1

Unpacking Capella
Capella is shipped in its own custom-made carton together with this
User Manual, a Packing Specification and standard accessories.
Please keep and store this carton in case you need to return the instrument to your supplier or to the factory for service or repair.
If the shipping carton is visibly damaged upon delivery, ask the carrier's agent to be present when the instrument is unpacked. If the instrument is damaged or fails to operate, please notify the carrier and
your supplier immediately. Your supplier will arrange for the repair
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or replacement of the instrument prior to settlement of any claim
against the carrier.
Please refer to the Packing Specification sheet enclosed with the instrument to ensure that all accessories are complete and intact.

2.2.2

Storage and shipment
See Section 3.1.9, ‘Storage & Shipment Environment” on page 27 for
specification of storage and shipment environment.
To protect the instrument and accessories during storage or shipment, always use the best packaging available. If it becomes necessary to return the instrument to your supplier or to the factory for
service or repair, please use the original shipping cartons, as recommended above. All products returned to GN Otometrics or its representatives must be shipped prepaid and insured, or you must
assume the risk of loss or damage in transit.
When shipping Capella, please remember to:
1.

Seal the shipping container securely.

2.

Mark the container FRAGILE to ensure careful handling.

3.

Refer to the instrument by make, model, and serial number in
any correspondence.

4.

Specify the problem and your preferred return shipping
address and arrangements.

Always store Capella in a clean, dry environment, and never leave
the power on when the instrument is in an enclosed container!

2.2.3

Inspection
Capella is a modular system which may be assembled from accessories chosen to meet the needs of different countries and practices.

GN Otometrics A/S
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The following lists are for general guidance and purposes of identification.
2.2.3.1

Equipment supplied
Capella Instrument
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.

Hardware platform
Probe Assembly, including preamplifier
Probe
Eartip Assortment
Shoulder Harness (standard) or Headband (optional)
Capella application module (software)
RS232C Serial Interface Cable
Probe Connector Cable
Power Cord
Capella User Manual including program diskette
Calibration Adaptors
Fuse Kits

Note:
Program diskette is located at the back of this manual!
2.2.3.2

Optional accessories
Echo-Screen probe
Eartip box with 2cc cavity
Carrying Case
Inkjet, or laser printer
Children´s Headband
M.E. Coupler
B & K Calibrator
8m Serial Interface Cable
Service Manual

2.2.4

Installation
Locate Capella in a well-ventilated room away from all liquids and
sources of heat (see Section 3.1.8, ‘Operating Environment” on
page 27 for detailed specifications of operating environment). Test-
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ing will be facilitated by a moderately quiet room, although a soundtreated booth is not necessary.
Note:
Capella is NOT suitable for use in the presence of a flammable anaesthetic mixture with air or with oxygen or nitrous oxide.
Connect the Probe Connector Cable and personal computer (PC) to
their respective ports on the Connection Panel at the back of Capella.
Before connecting the power cord, please make sure that the voltage
from the electrical outlet matches the voltage shown on the identification label stuck over the power inlet.
Caution!
Operating at the wrong voltage may blow the fuses!
Plug one end of the supplied power cord into the power inlet on the
back of Capella (see Fig. 1 below) and plug the other end directly into
a three-wire, protective ground, AC power outlet.

Headset

Data Interface
100-240V
50/60Hz 55VA

T1A L/250V

1

2

Figure 1
For more information about installation, set up the Capella software
on your PC (Section 3.3, ‘Starting up the system” on page 28) and
then refer to the section on "Installation" in the on-line help.

2.3

Care and maintenance
The probe, headset and parts are in constant contact with your patients so care should be taken to ensure that they are kept clean.

2.3.1

Probe
Proper treatment of the Capella combination probe is important. It
contains delicate transducers, precisely calibrated to work with your

GN Otometrics A/S
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instrument. It should not be dropped, brought in contact with liquids, or otherwise maltreated.
However, the probe tip should be inspected periodically for foreign
matter at the end of the tip. To clear cerumen, vernix and other debris from the tip, follow the instructions below:
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1.

Brush the probe every time after use with the cleaning tool
supplied. If cerumen or vernix is pushed up inside the probe
housing, the probe will be damaged. Brush in a direction away
from the probe housing, towards the tip of the probe.

2.

The probe should never be placed directly in water or other
cleaning liquids. Liquids seeping into the housing will damage the probe.

3.

When fitting a new eartip to the probe, ensure it is pushed all
the way to the probe casing, so there is no gap between the
eartip and the casing. The top should be flush with the end of
the probe tip.

4.

Caution!
Do not allow the probe body, which contains the acoustic
transducers, to come in contact with any liquids.

5.

The probe cannot be dismantled - this is not necessary for
cleaning if the care instructions are followed.

6.

Do not fit the probe by holding on to the cable as you could
damage the pin connector by doing this.

GN Otometrics A/S
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Probe body

Probe tip Eartip

Probe cable

2.3.2

Eartips
Capella eartips are designed to fit over the end of the probe and permit a tight seal in the patient's external ear canal. Please see the instructions on the eartip assortment box for proper attachment on the
probe tip.
Use a new eartip for every patient. Select an appropriately sized eartip for the patient’s ear canal - the eartip should fit snugly. Use only
the eartips supplied with this probe.
Eartips should be used on only one patient. The eartips are in direct
contact with your patients, and you should therefore observe strict
hygienic precautions to prevent passing infections from one patient
to another. It is therefore recommended that you use only disposable
eartips.
Most eartips are disposable, and should not be cleaned or re-used.
Always throw away disposable eartips after use on a patient.

2.3.2.1

Disposal
There are no special requirements for disposal of the rubber eartips,
i.e. they may be discarded in any regular waste bin.

2.3.2.2

Portable use
Capella is a fully portable system, but the optional carrying case is
recommended for safe transportation. Before packing the system,

GN Otometrics A/S
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ensure that the probe assemblies, eartips, etc., are not loose in the
case.
Note:
Eartips for Capella and Madsen´s Zodiac 901 Middle-Ear Analyzer
are interchangeable.

2.3.3

Hardware platform
Capella requires no preventative maintenance. However, it is recommended that the following guidelines be observed:
The instrument should be kept clean and as free of dust as possible:
•

Remove dust using a soft cloth or brush.

•

To clean, use a soft, slightly damp cloth with a small amount
of mild detergent on it. Do not allow any moisture inside the
instrument or probe.

Caution!
Chemical agents containing ammonia or alcohol will damage the
cabinet.
Avoid exposing the instrument to direct sunlight, and keep it wellventilated at all times to prevent overheating.

2.4

Fuse replacement
Two identical fuses are located in the connection panel between the
power inlet and the on/off switch. To replace a fuse, please proceed
as follows.
1.

Disconnect Capella from mains/line power supply.

2.

The black plastic fuse holder may be extracted from the fuse
compartment using a small screwdriver to press back the clip
in the middle left of the holder.

3.

When loose, extract the holder and change fuses - refer to the
fuse specifications marked above the on/off switch.

Warning!
When replacing the fuses there is a risk of fire. For continued protec-
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tion against fire hazard, replace fuses with the same type and rating
only.
4.

2.5

Replace the fuse holder by pushing it firmly into place - an
audible click can be heard (the holder cannot be replaced back
to front).

Equipment failure
If you believe the correct function or operating safety of Capella is
impaired in any way, disconnect it from the power supply and secure it against further use.
Caution:
Under no circumstances remove the Hardware Platform's cover!
Contact your local representative that supplied Capella.

2.6

Battery powered version
The optional battery powered version of Capella utilizes a rechargeable Ni-MH battery pack. The battery pack is located inside the
Capella cabinet, and is NOT to be accessed by unauthorized personnel.
If you experience any problems with recharging the battery pack, or
operation on battery power only, please contact your local supplier.

2.6.1

Battery replacement
For authorized personnel only:
1.

Disconnect Capella from AC power source.

2.

Unscrew the 4 screws which secure the cabinet to the baseplate.

3.

Replace the battery pack with a new one, type HHR-380A/
L2x3 (7.2V, 3800mAh).

4.

Dispose of the battery pack by sending it to an authorized NiMH battery destruction facility.

Do not attempt to disassemble the battery pack.
Do not incinerate the battery pack, or expose to fire.

GN Otometrics A/S
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Battery operation
When connected to an AC power source, the battery version of
Capella will automatically recharge the battery pack, whether Capella
is powered on or off. When powered on, the Power LED (see Figure
3) will light continuously green, and the AC/Charge LED will light
as follows:
Yellow = charging
Green = fully charged
If the battery is allowed to become exhausted, the AC/Charge LED
will not indicate charging until about five minutes after AC power
has been applied. When not connected to an AC power source, the
Power LED will light green when Capella is powered on, and the
AC/Charge LED will not light. Capella cannot be operated if the battery pack is dead, not even when connected to the mains (line).
Note:
In order to disengage the battery pack of Capella completely from an
AC power source, it is not sufficient to power the instrument off. The
power cable must be detached from the power source.

2.6.3

Battery life
When fully charged, Capella can operate for approximately 5 to 7
hours of constant use, up to 22 to 24 hours´ "typical" usage, and up
to 38 hours´ stand-by, i.e. powered on, but not in use.
The life of the rechargeable battery pack depends on too many variables to be estimated, but you are advised to follow the normal rules
for maximizing battery life: avoid constant recharging when not in use,
and completely exhaust the batteries periodically (once every 6
months).
A memory effect will occur when a user repeatedly recharges the battery before it is fully drained. For example, if you use the battery for
20 minutes at a time and then recharge it, the battery will tend to "remember" that it needs to operate only 20 minutes per charge. As a
result, during the charging process, the declining battery will receive
only a portion of its charge capacity. The declining battery will also
exhibit some characteristics of a fully charged battery. For example,
during charging, the battery temperature will rise, prompting the
system to stop charging.
The memory effect also has a direct impact on the battery's life span.
Ni-MH batteries have a typical life (charge/drain cycles) of up to 800
cycles. If the battery is used an average of 30 minutes per cycle, you
can expect a total life of 400 hours. If you use the battery 6 hours per
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cycle, you can expect a total life of 4800 hours. Therefore, it is advantageous to use the battery as much as possible during each cycle.
Ni-MH batteries should not be subjected to longer periods of deep
discharging, to prevent polarity reversal of individual cells. The
worst thing for a battery is to remain fully discharged for long periods of time. This causes sulfation, which is a hard lead sulfate coating on the plates. Sulfation can reduce battery capacity dramatically.
If a battery has been deep discharged, the charge LED will light
green when the mains are connected, and after 3-30 seconds the
green colour will change to orange. If the AC/Charge LED doesn't
change colour back to green within the first 10 minutes, disconnect
the mains supply for a few seconds and then reconnect it.

2.7

Service and repair
Service and repair of electro medical equipment should be carried
out only by the equipment manufacturer or by authorized representatives.
The manufacturer reserves the right to disclaim all responsibility for
the operating safety, reliability and performance of equipment serviced or repaired by other parties. Following repair, the safety of all
equipment should be verified by a qualified electronics engineer.

2.8

Start-up
Power Capella on by means of the on/off switch. The start-up process is as follows: on power-on, the Power LED (see Figure 3) lights
green, and a brief system test is made. The PC Com LED lights green
once, indicating that Capella is ready for communication with your
PC. There is no warm-up time required.

Figure 3
Communication between your PC and the Hardware Platform is indicated by the PC Com LED, which flashes green. If you attempt
communication with Capella without powering it on, you will be ad-

GN Otometrics A/S
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vised on-screen of a timeout error: power Capella on, wait a few seconds and Retry.

2.9

Calibration
Your Capella was dispatched from the factory in Denmark together
with a Test Report (Calibration Certificate). The Test Report specifies
which transducers have been calibrated (i.e. those which have been
supplied together with the instrument), according to which standards, and what equipment was used for calibration. Results are listed for each transducer at all standard frequencies.
For DPOAE, Capella is calibrated in dB SPL (1 dB SPL = 20 µPA); for
TEOAE, Capella is calibrated in dB peak.
Calibration has been performed on the supplied probe. If you wish
to use any other probe for testing with Capella, please contact your
local supplier first.
Calibration should be performed annually by suitably qualified personnel, using the appropriate equipment.
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General Description
The CAPELLA Cochlear Emissions Analyzer is an audio diagnostic instrument designed to measure two broad classes of otoacoustic
emissions, Spontaneous and Evoked. Capella consists of the following:
1.

The hardware platform, which houses the power supply and
printed circuit boards for signal generation.

2.

The probe assembly, which contains the preamplifier.

3.

The probe body, which contains a microphone and two receivers.

4.

A headset and earphone or a shoulder harness and a set of
color-coded eartips to stabilize the probe and probe assembly
when the probe tip is placed in the external ear canal.

5.

Operating software, which delivers signal generation and
other instructions to the hardware platform and collects data
from the hardware platform. Includes a comprehensive online Help to assist the user.

6.

Various cords and cable connections, including an RS232C
computer interface.

7.

This User Manual, which provides general information about
the theory and technique involved in the measurement of
otoacoustic emissions, as well as specific instruction in the use
of Capella.

8.

A laminated Quick Guide.

Some test parameters are pre-programmed and stored in non-volatile memory on the printed circuit boards of the main electronics
unit. These parameters are retained when the power supply is cut
off, but can be reprogrammed or upgraded from a personal computer by authorized personnel as necessary. Other test parameters are
selected from the computer using the keyboard or various function
keys.
The hardware platform has three LED displays indicating power on,
battery status, and signal and response transmission (PC Com).

GN Otometrics A/S
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3.1

Technical specifications

3.1.1

Distortion-Product Otoacoustic Emissions (DPOAE)

Stimulus

2 sinus stimulus channels

Geometric Center Frequencies

0.5, 0.75, 1.0, 1.5, 2.0, 3.0, 4.0, 6.0, 8.0 kHz

Stimulus Level Range

0 - 70 dB SPL

Stimulus 3rd order Intermodulation< -80 dB
Input Sensitivity For Stimulus

PC Readout:
800 point FFT analysis

≥50 dB SPL: 80 to -30 dB SPL
< 50 dB SPL: 60 to -50 dB SPL

Fsample
26.04 kHz
13.02 kHz
6.51 kHz

Fmax
10 kHz
5 kHz
2.5 kHz

Resolution
13 Hz
6 Hz
3 Hz

Frequency Response Accuracy:
Microphone

± 3 dB from 500 to 4000 Hz
± 6 dB from 4000 to 9000 Hz

Sound Level

711 Coupler Reference (volume compensated)
± 4 dB from 500 to 4000 Hz
± 7 dB from 4000 to 9000 Hz
In Situ Sound Level Adjustment
± 4.5 dB from 500 to 4000 Hz

3.1.2

Transiently Evoked Otoacoustic Emissions (TEOAE)

Stimulus

24

Non-linear:

3 clicks of the same polarity and 1 click of opposite polarity, at 3
times the amplitude of the 1st click. Pulse width 40, 80, 120 µsec.

Stimulus Level Range

30 - 80 dB p.e. SPL approx. -30 to 60 dB nHL

Linear:

Unipolar click. Pulse width 40, 80, 120 µsec.

Stimulus Level Range

30 - 80 dB p.e. SPL approx. -30 to 60 dB nHL

Level Accuracy

± 4 dB

GN Otometrics A/S
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Stimulus:

3.1.3

Acoustical Bandwidth

500 - 4000 Hz ± 5 dB @ 1000 Hz

Input Resolution

Measurement range:
Time domain: 1 µPa/div. to 1 Pa/div.
Freq. domain: -30 dB to 10 dB SPL

Spontaneous Otoacoustic Emissions (SOAE)

Input Sensitivity

0 - 70 dB SPL

Frequency Ranges

500-5000, 500-10,000 Hz

3.1.4

Echo-Screen

Sound stimulus level:

70 to 85 dB SPL, self-calibrating to ECV (Ear Canal Volume)

Stimulus rate:

40...100 Hz

Stimulus type:

Nonlinear click

Signal bandwidth:

1.4 to 4 kHz

Max. sound pressure:

Limited to 85 dB SPL

Probe:

Eartips from 4 to 10 mm dia.

Signal processing:

Binomial statistical analysis of TEOAE sweeps for signal to noise ratio. 99% confidence-level analysis of a time window from 6 to 12 ms
after the stimulus, ranked in four quality buffers

Result display:

"Pass" or "Refer", based on the acquisition of four pos. and four neg.
peaks

Data display:

Elapsed time, no. of peaks, no. of sweeps in each buffer, noise, artifact rate, stimulus stability, signal quality, no. of accepted sweeps,
no. of rejected sweeps, percentage of completed sweeps

Graphic display:

Pos. and neg. significance level as a function of time after stimulus

GN Otometrics A/S
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Tympanometry (immittance measurements)

Standards:

EN 61027, ANSI S3.39

Pump direction:

Neg. to pos. and pos. to neg. selectable

Pump accuracy:

±10% or ±10 daPa, whichever is greater. Plunger-type pump controlled digitally by stepper motor

Pressure range:

-400, -350, -300, -250, -200, -150, and -100 daPa to 100, 150 and 200
daPa

Pump speed:

50, 100, 200 and 400 daPa/sec plus As Fast As Possible

Probe tone:

226 Hz at 85 dB SPL and 1000 Hz at 75 dB SPL, selectable

Volume range:

0.1 to 8 ml

Y-axis scaling:

0.3, 0.6, 0.9, 1.5, 3, 4.5 ml and Auto

Smoothing:

On/off selectable before or after measurement

Sweep start:

From probe, from screen, or automatic when volume detected

Leak detect:

On/off selectable

Air release:

From screen or from keyboard or automatically if pressure exceeds 800 daPa or 600 daPa

Measurement status:

Pop-up box displays pump position and status messages in real time

Tympanogram characteristics
displayed:

Cartesian tymp. plot; current measured volume and static pressure
in real time; calculated values for ECV, MEP, SC, Grad, TW; and
tymp. Type (A, AD, AS, B, C, D, E)
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Power Supply
AC 50/60 Hz, 100-240 V AC
Fuses Type 1A T (accessible from outside the cabinet)
Power Consumption:Approx. 55 VA
Battery pack (optional):type HHR-380A/L2x3 (7.2V, 3800mAh)

3.1.7

Patient Safety
Complies with EN 60601-1, Class 1, Type B, IPX0.
Battery version complies with EN 60601-1, Class I, Internal Powered,
Type B, IPX0.

3.1.8

Operating Environment

Mode of operation:

Continuous

Temperature:

10° - 35°C

Relative Humidity:

30 - 90%, non-condensing

Atmospheric Pressure:

600 - 1090 hPa

Operation in temperatures exceeding -20°C or +60°C may cause permanent damage.

3.1.9

Storage & Shipment Environment

Temperature:

-20°C to +60°C

Relative Humidity:

30 - 90%, non-condensing

Atmospheric Pressure:

600 - 1090 hPa

3.1.10

EMC

EMC Emission and Immunity:

GN Otometrics A/S

Complies with EN 60601-1-2
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Dimensions and Weight

Hardware platform:

Approx. 305 x 284 x 59 mm (W x D x H),
12" x 11" x 2¼"

Net Weight:

Approx. 1.8 kg, 4 lbs (excl. PC)

Probe assembly:

73 g, 2.6 oz.

Probe:

14 g, ½ oz.

3.2

Manufacturer
GN Otometrics A/S
9 Hoerskaetten, DK-2630 Taastrup, Denmark
Phone: +45 45 75 55 55
Fax: +45 45 75 55 59
www.gnotometrics.com

3.3

Starting up the system
First access Client Module (NOAH only)
On the NOAH toolbar, only the first icon (Client Module) and the
last icon (Help) are active until a client has been selected-all the others are greyed (inactive). Before proceeding to any of the application
modules, it is first necessary to access the Client Module, and then
to either select an existing client or to add a client to the database.
You are referred to the NOAH or PAX User's Guide for detailed navigation instructions.
After having selected or added a client, click on the Selection of
Measurement Module icon which opens the NOAH/PAX Measurement Selection Screen. Double-click on the Capella button. The
Capella software will now be loaded, and the program will start by
trying to connect with the Capella hardware platform.
If the Capella hardware platform has not been powered on, or if the
platform has not been connected correctly to your PC, you will be
prompted to retry or ignore.
The Capella software is delivered with a comprehensive built-in electronic assistant. Click on Help to obtain answers to queries about
testing patients using Capella.
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Operation
This manual assumes familiarity with Microsoft Windows™ and the
NOAH™ or PAX™ platforms if used, and that the patient has been
also prepared with visual inspection of the ear canal. For more information about using Capella, click on Help.

The icons above are used to navigate around Capella.
Note:
If any of the measurements made using Capella is found to have inadvertently been made with the wrong ear selected, open the Ear
menu and choose Swap ear data... . Then select This measurement only, All measurements for current mode (and current ear), All measurements for current ear (all modes), or
Selected measurements. If necessary, select the measurements
to be moved from the list, and then click on OK.
To clear all measurement data for all modes and for both ears from
the current session, select Clear all in the File menu or click on the
Clear all icon in the toolbar. When this function is used, the Probe
Fit operation will have to be repeated before any more measurements can be made.

4.1

Probe fit

GN Otometrics A/S

1.

Click on the Ear icon to select the ear you wish to measure, or
select Right or Left in the Ear menu.

2.

Mount a suitable eartip on the probe and insert it into the ear
canal, obtaining a tight seal with the canal wall.
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3.

Enter Probe fit mode by clicking on the Probe fit icon or
choosing Probe fit in the Mode menu.

4.

Click on Start to check the probe fit. If necessary, adjust the
probe in the ear canal until the curve falls within the red
hatched area.

5.

Probe fit will automatically stop when an adequate fit is
obtained, and a message will appear informing you that the fit
is either good or acceptable. The probe fitting process can be
terminated manually by clicking on Skip.

6.

The Fit dot on the lower left part of the measurement screen
allows you to monitor the status of the probe fit. Green indicates a good fit, yellow indicates an acceptable fit and red indicates a poor fit (or that the probe fit procedure was not carried
out).

1.

Click on the Echo-Screen icon or choose Echo-Screen in
the Mode menu.

2.

Press Start to begin screening.

3.

When the screening is complete the Result will display green
for Pass, red for Refer, and gray if a significant result was prevented by a leak or noise.

4.

Up to 6 measurements can be made for each ear. Click on the
arrow keys in the Meas. No. box on the lower left to make a
new measurement or to view other measurements made on
the same ear during the session.

5.

Repeat the procedure beginning with Probe fit for measuring
the other ear.

ECHO-SCREEN

GN Otometrics A/S
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TEOAE
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1.

Click on the TEOAE icon or choose Transient (TEOAE) in
the Mode menu.

2.

Change stimulus level by clicking on the Stimulus arrow
keys or pressing the up and down arrow keys on the keyboard.

3.

Access to additional test parameters (selection of Linear,
Nonlinear or Fast-screen mode, Stimulus suppression,
Noise criteria and Stop criteria) can be gained by selecting
Parameters in the Setup menu. If necessary, change the
Stimulus correction in the Setup menu.

4.

Click on Start to begin measuring.

5.

If you wish to halt the measurement momentarily, click on
Pause. Click on Continue to resume the measurement.

6.

Measurement status can be monitored by observing the
Sweeps and Statistics boxes on the lower right part of the
screen. The Correlation, Emission strength and S/N ratio
are shown in each of five frequency bands as well as the
broad-band values. The blue vertical bar on the right of the
time response graph also indicates the noise floor during the
measurement.

7.

Click on Stop to end the measurement if you have disabled
Stop criteria.

8.

Scaling of the time response graph can be changed by using
the up and down arrows in the Scale box on the screen or
the PgUp and PgDn keys on the keyboard.

9.

The cursor can be moved by clicking on the time response
graph or using the right and left arrow keys in the Cursor box
on screen or on the keyboard. The cursor's position on the time
scale and the amplitude of the mean of the A and B curves are
displayed in the Cursor box.

10.

The time window for data analysis can be changed by entering
different values in Window in the Parameters dialog box
(Setup menu) but this not generally recommended as it can
affect the correlation coefficient substantially. If displayed, the
gray hatched area is not included in the FFT analysis. The
Scaling of the FFT display may also be altered and its
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Smoothing and or Microphone correction turned on or
off from this dialog box.

4.4
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11.

Up to 6 measurements can be made for each ear. Click on the
arrow keys in the Meas. No. box on the lower left to make a
new measurement or to view other measurements made on
the same ear during the session.

12.

Repeat the procedure beginning with Probe fit for measuring
the other ear.

DPOAE: DP-gram
1.

Click on the DP-Gram icon or choose Distortion Products
(DPOAE) in the Mode menu and DP-Gram in the submenu.

2.

Select Parameters in the Setup menu to define the Level
Difference between f1 and f2, select either 2f1-f2 (DP1) or
2f2-f1 (DP2) for analysis, and if required change Noise criteria, Stop criteria and Noise estimate.

GN Otometrics A/S
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3.

Change the stimulus level by clicking the arrow keys in the F1
Level box or pressing the up and down arrow keys on the
keyboard.

4.

Indicate the desired frequencies by clicking in the appropriate
boxes under the DP-Gram.

5.

Click on Start to begin measuring. When the stop criteria for
one frequency have been met, measurement will automatically resume on the next preselected frequency.

6.

Click on Stop to end the measurement if you have disabled
Stop criteria. To resume measurement on the next preselected frequency, click on Start.

7.

If you wish to halt the measurement momentarily, click on
Pause. Click on Cont. to resume the measurement, at the
same frequency.

8.

Measurement status can be monitored by observing the
Sweeps and Statistics boxes on the lower right part of the
screen. The noise floor during the measurement is also indicated by the blue vertical bar to the right of the DP-Gram.
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9.

Use the right and left arrow keys in the Frequency box on
screen or on the keyboard to view the amplitude spectra for
different frequencies.
Data for the selected frequency appear in the Sweeps and
Statistics boxes, and in the boxes labeled DP1 and DP2.
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10.

The DP1 and DP2 and noise values can be viewed in a tabular
form by choosing DP Tabular on the View menu. Information regarding the f1:f2 ratio, primary and DP frequencies, primary levels and DP phases can be viewed by choosing DP
Info on the View menu.

11.

The default pattern showing normative data in the DP-Gram
display is for adults, measured at the University Hospital of
Copenhagen. To show the corresponding pattern for babies
instead, select Norm. data in the Setup menu and click on
baby. Amongst the other normative data patterns which may
be selected from this dialog box is the Gorga norm. Confirm
the selected norm by clicking on OK. The normally green DPdot turns yellow if lower than the noise floor or outside the
dynamic range of the instrument.

12.

Up to 6 measurements can be made for each ear. Click on the
arrow keys in the Meas. No. box on the lower left to make a
new measurement or to view other measurements made on
the same ear during the session.

13.

Repeat the procedure beginning with Probe fit for measuring
the other ear.
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DPOAE: Input/Output
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1.

Click on the DP-I/O icon or choose Distortion Product
(DPOAE) in the Mode menu and DP-IO in the submenu.

2.

From Parameters in the Setup menu. select DP1 or DP2 for
analysis, change if required Noise criteria, Stop criteria
and Noise estimate, and define Start level, Increment
and Stop level. The DP-I/O measurement will be carried out
automatically only if stop criteria are defined. If this is not the
case, you must click on Stop to end the measurement, use the
up and down arrow keys on the keyboard or on screen to
change the F1 level, and then click on Start to resume measuring.

3.

Select frequency by using the right and left arrow keys on
the keyboard or in the Frequency box on screen.

4.

Click on Start to begin measuring.

5.

If you wish to halt the measurement momentarily, click on
Pause. Click on Continue to resume the measurement.

6.

Measurement status can be monitored by observing the
Sweeps and Statistics boxes on the lower right part of the
screen. The noise floor during the measurement is also indicated by the blue vertical bar to the right of the DP-Gram. The
normally green DP-dot turns yellow if lower than the noise
floor or outside the dynamic range of the instrument.

7.

Click on Stop to end the measurement if you have disabled
Stop criteria.

8.

Use the up and down arrow keys on the keyboard or in the
F1 Level box on screen to view the amplitude spectra and
data for the various presentation levels.

9.

Up to 6 measurements can be made for each ear. Click on the
arrow keys in the Meas. No. box on the lower left to make a
new measurement or to view other measurements made on
the same ear during the session.

10.

Repeat the procedure beginning with Probe fit for measuring
the other ear.
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SOAE
1.

Click on the SOAE icon or choose Spontaneous (SOAE) in
the Mode menu.

2.

Select Parameters in the Setup menu to choose the bandwidth for the measurement, the criteria for stopping the measurement automatically (if desired), the noise reject level, and
the S/N ratio for automatic identification of an SOAE. Click
on OK.

3.

Click on Start to begin measuring.

4.

If you wish to halt the measurement momentarily, click on
Pause. Click on Continue to resume the measurement.
Measurement status can be monitored by observing the
Sweeps box on the lower right part of the screen.

5.

Click on Stop to end the measurement if you have disabled
Stop criteria.

6.

The frequency range shown in the SOAE response spectrum
window extends to half of the measured frequency bandwidth. Use the scroll bar under the response spectrum to view
other frequencies.

7.

Move the cursor by using the left and right arrow keys on the
keyboard, by clicking on the arrow keys in the Cursor box on
screen, or by clicking on the response spectrum itself at the
point where you want to position the cursor.

8.

Click on Next to identify the next SOAE according to the
defined S/N criteria. The spike will be marked on the graph
with , and data listed in the box in the upper right hand corner of the screen.

9.

Click on Auto to automatically identify SOAEs according to
the defined S/N criteria. These will be listed in the box, and
the spikes on the graph marked with .

10.

SOAEs can be manually marked by double-clicking on them
on the graph. These will also be listed in the upper right hand
corner of the screen.

11.

If any spikes have been either manually or automatically
selected which you do not wish to have identified as SOAEs,
they can be deleted by double-clicking them in the list or on
the graph.

12.

Up to 6 measurements can be made for each ear. Click on the
arrow keys in the Meas. No. box on the lower left to make a
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new measurement or to view other measurements made on
the same ear during the session.
13.

4.7

Repeat the procedure beginning with Probe fit for measuring
the other ear.

Tympanometry

GN Otometrics A/S

1.

Click on the Tympanometry icon or choose Tympanometry in the Mode menu. If the patient shows signs of distress
at any time, release the air pressure by clicking on Air
release (F5) or pressing F5 on the keyboard.

2.

If required, reduce measurement time by clicking on the up
arrow in the Pump speed box. A.F.A.P. means "As fast as
possible".

3.

To alter other settings (pump pressure range and sweep direction, display scaling and smoothing, auto start, measurement
increment, and stop when results available), select Parameters in the Setup menu and choose different settings as
required.

4.

Select probe tone in the Frequency box.

5.

To prevent the sweep from restarting if a leak is detected, click
Off in the Leak detect box.

6.

If auto start has not been selected, click on Start to begin
the sweep. If a leak halts the sweep or the Pump position
displayed during the sweep is seen to reach either of its end
stops, try to improve the seal between the eartip and the ear
canal, and then sweep again.

7.

To compare the recorded tympanogram with norm data, click
on Setup and then on Norm data. Click on the option
required and then click on OK.

8.

Up to 3 tymp. measurements can be made for each ear. Click
on the arrow keys in the Meas. No. box on the lower left to
make a new measurement (if Enable meas. no. increment
has not been checked in Setup) or to view other measurements made on the same ear during the session.
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Importing old Celesta files
To retrieve saved measurement results made using Celesta, proceed
as follows:

4.9

1.

Go to the File menu.

2.

Select Open old Celesta files...

3.

If necessary, select Drive. Click on the arrow down icon to
show the available drives and then click on the one containing
the required files.

4.

If necessary, select Directory. Double-click on [..] to move
down the directory tree, or double-click on one of the other
displayed directories to select it or to move up the tree.

5.

There are three kinds of measurement mode: TEOAE, DPOAE
and SOAE. Select the required patient and mode and then
click on OK.

Comments
You can append comments by selecting Edit comments from the
File menu -- 4 lines of comments can be written per session. These
comments are displayed on NOAH's session list, and can be included on the printout.

4.10
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User configuration
1.

From any measurement mode, all setup and test parameters
can be saved as a specific user configuration. Select User in
the Setup menu. Type a name or initials in the New user
box, and click on Save.

2.

Confirm Save user setup file by clicking on OK. Click on
OK again to exit.

3.

Alternatively, you can revert to the default configuration or
select another configuration using this feature. Click on the
desired user setup file to select, and then on OK to exit.

4.

You can also delete an old user setup file by selecting it, and
then Delete. You will be prompted to confirm the deletion.

GN Otometrics A/S
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Auto sequence
To permit automatic testing, Capella has a built-in macro function.

GN Otometrics A/S

1.

First complete Probe fit for the ear to be tested, and then
select Auto sequence from the Setup menu or click on the
Auto sequence icon.

2.

Select an existing Auto sequence from the box, and click on
Run to start measurements in the predefined sequence and
with the predefined parameters. The measurement can be
interrupted at any time by clicking on Pause, or the Auto
sequence can be terminated prematurely by clicking on the
Stop button in the Auto Sequence run box.

3.

To create a new macro, type a name into the New Auto
sequence box and then click on New. Select the measurement modes you wish to test with, type the number in the
sequence under Mode order, choose the Number of measurements you wish to make for each mode, and then set up
each measurement mode by means of Parameters. If
required, choose the Break condition for Probe fit, EchoScreen and Tympanometry. Remember that each Auto
sequence is for one ear at a time, i.e. to test both ears you must
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first change ear, perform a Probe fit and then run the Auto
sequence.

4.12

4.

After creating a new Auto sequence, click on Run to execute it,
or Close to exit from the dialog box.

5.

Any existing macro can be deleted or edited from the Auto
sequence box.

Compare
Use this function to compare measurements made on the same client's ear over time:

40

1.

Select Compare from the File menu.

2.

Choose TEOAE, DP-Gram or DP-I/O from the Mode menu as
required.

3.

Click on Open session in the File menu to find the data to be
compared.

4.

Click on the first session to be compared, then on OK, and
then select another measurement if required by means of the
left or right arrows in the Session sub-window.

5.

Repeat step 4 up to five times. Each successive measurement
result will be assigned a session number and superimposed on
the others on the graph. To display the corresponding measurement parameters and/or statistics, select Param. and/or

GN Otometrics A/S
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Statistics in the View menu and then click on the Session
sub-window with the corresponding session number.

4.13

Printing measurement results and comments
Capella has a very versatile printout function, which can be comprehensively configured to your own requirements.
•

You can register up to four lines of comments per session by
selecting Edit comments from the File menu.

•

To print out measurement results (with any comments) using
the default setup, select Print from the File menu, and then
This mode, Overview or All.

•

To configure a new print setup or select a different existing
named setup (Load Setup), select Print layout in the File
menu.

•

Portrait or landscape format may be set up by clicking on
Select Printer.

To add an image to the current page, proceed as follows:

GN Otometrics A/S

1.

Click on the arrow to the right of the selection bar at the top of
the dialog box.

2.

Click on the required image.

3.

Click on Add Image.

4.

Drag the image to the required position on the page.

5.

Use the right mouse button to identify a selected image
(Show Description), bring it to the Top or Bottom, or
Delete it from the page.

6.

The size of an image may be changed by clicking on an edge
or a corner.

7.

When the setup is complete, click on Save Setup and assign
a name to it.
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